FA24 Telecommunications Systems Engineering Course

                                                        Network Management Practical Exercises 
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OBJECTIVES
The intent of this experiment is two fold: to familiarize the student with some of the areas that OSI has defined as management functional areas and to provide the student an understanding of the Simple Network Management Protocol (SNMP) and its use in network management.  This will be accomplished by examining the network, in-depth, through the exploration of MIBs.  Four different software programs will be utilized: Compaq Network Management Software (CNMS), SNMPUTIL, MG Soft MIB Browser and HP OpenView.

INTRODUCTION

Computer networking has become a critical production tool for many businesses and organizations.  A failure of networks or not well-designed networks can possibly cause a lost of millions of dollars.  Efforts on how to manage a reliable, cost-effective, and secure network have, thus, become an important issue for many network users.  To address this issue, International Organization for Standardization (OSI) has defined 5 management functional areas as network management guidelines.  The 5 areas are fault management, configuration management, accounting management, performance management, and security management, and are explained in the following table.

	Fault management
	The facilities that enable the detection, isolation, and correction of abnormal operation of network objects

	Configuration management
	The facilities that enable the control, add, delete, and modify of managed network objects.

	Accounting management
	The facilities that use to generate charges or identify costs of usage of managed network objects.

	Performance management
	The facilities that use to analyze the effectiveness of managed network objects, such as utilization of BW and server processing power.

	Security management
	The facilities that use to prevent hazardous action/behavior from damaging the normal function of managed networks.


During the various labs, emphasis will be predominately based on fault and performance management.  We will learn how to collect data and analyze the data by using several different network management tools.

One way to achieve network management tasks, such as the five areas specified by OSI, is to perform a regular “network audit.”  Network audit is a serial of steps that are designed to facilitate network management.  It covers all aspects of the physical and logical layout.  Those steps include network documentation, baseline creation, and network health analysis.  The network documentation is a process of bookkeeping network components.  For example, it can include hubs, routers, and servers, their physical locations, the number of interfaces on a router, the processing power of a server, the user of a host, and so on.  Detailed network documentation can simplify fault discovery, troubleshooting, and maintenance of networks.  To see the power of network documentation, image a user called and reported that he/she cannot access a network. A network technician can inspect whether the link between the host and hub is good by quickly checking the light indicator of the hub port status (on or off). Without the network documentation, which records the physical location of the user host and the hub port of the host connecting to, this fault discovery is hard to be achieved quickly.  To be able tell an abnormal activity of a network at one point; one should have a reference of normal network status to compare to.  The reference can be acquired by collecting the status of networks in the normal operation of the network, which usually include the network utilization and the server CPU usage over a period of time.  This type of reference is known as a network baseline. The primary scope of network health analysis can be divided into the physical, data link, and network layers of those in OSI model as shown below.  

	OSI Model
	Examples of Check Points
	Network Audit

	Network Layer
	Responding time, protocol discovery, top senders, traffic analysis
	Evaluate the Network Health

	Data Link Layer
	Link utilization, broadcast frame, collision, top senders
	Checking the Data Link Health

	Physical Layer
	Wiring, connectors, NIC
	Evaluate the Physical Layer


Simple Network Management Protocol (SNMP)
The Simple Network Management Protocol (SNMP) communicates management information between a manager and agents. The manager can be any machine running management software, while the agent is any network device running agent software or supported by an agent proxy.  Network devices include routers, hubs, switches, etc.  SNMP was designed to work in a multi-vendor environment and operates over UDP (User Datagram Protocol).  See Figures 1 and 2 for the manager and agent protocol stacks.  

· Management applications are the processes that allow you to initiate management tasks and collect management information.  Three types of messages are issued by a manager:

· GetRequest

· GetNextRequest

· SetRequest




Figure 1:  Management Protocol Stack
· Agents are processes running on the network device.  The agent interprets incoming SNMP messages. Agents respond to GetRequest, GetNextRequest, and SetRequest with GetResponse.  An agent may also issue a trap, which is a message caused by exceeding a threshold defined on the agent device.  Network objects that do not have the agent software loaded will return a message stating the agent software is not loaded when queried by the manager application's GetRequest—and in some cases they will not respond at all to the GetRequest.




Figure 2:  Host Protocol Stack

· Proxy agents accommodate devices that do not support SNMP.  The management station queries the proxy.  The proxy agent then queries the device using the management protocol supported by the device.  The proxy agent then receives replies from the device and sends them back to the management station via SNMP.

RMON
A supplement to SNMP is RMON.  RMON debuted in 1991 and extended management capabilities to the LAN.   In 1996 RMON was extended by RMON2.  RFC 1757 describes RMON devices as:

Remote network monitoring devices, often called monitors or probes, are instruments that exist for the purpose of managing a network. Often these remote probes are stand-alone devices and devote significant internal resources for the sole purpose of managing a network. An organization may employ many of these devices, one per network segment, to manage its Internet. In addition, these devices may be used for a network management service provider to access a client network, often geographically remote.

Management Information Base (MIB)

Network Management applications rely on a Management Information Base (MIB) that contains definitions of the objects being managed, the agents that are available, and the requests that have been made to agents.  The management database contains definitions of each type of object.  

MIB objects are conceptually organized in a hierarchical tree structure.  Each branch in the tree has a unique name and numeric identifier.  Intermediate branches of the tree serve as a way to group related MIB objects together, as illustrated in Figure 3.  A MIB object is uniquely identified (named) by its place in the tree.  A full object identifier consists of the identifier of each branch along the path through the tree hierarchy.  For example, to access the system group, the correct identifier would be 1.3.6.1.2.1.1.  For more information on MIBs and their structure, please refer to the references at the end of each section.




Figure 3:  MIB Structure
HP OpenView Network Node Manager

HP OpenView NNM is a comprehensive set of tools and services you can use to perform fundamental tasks in managing a distributed TCP/IP network.  The OpenView tools provide both management applications and agent software using SNMP protocol.  Different manufacturers such as Cisco and Bay Networks provide the agent software. 

SNMPUTIL

SNMPUTIL is a command line SNMP utility that enables the user to get SNMP information from an SNMP host on the network.  This raw utility is part of the Resource Kit for Windows 2000 Operating System.  

MGSoft MIB Browser

MG-SOFT MIB Browser Professional Edition with MIB Compiler is an SNMP MIB Browser running on Microsoft's 32-bit operating systems (Windows 95, Windows 98, Windows ME, Windows NT, Windows 2000). MIB Browser lets you monitor and manage any SNMP device on the network (i.e. file or database servers, routers, hubs, switches, bridges...) by using the standard SNMPv1, SNMPv2c and SNMPv3 protocols.  MIB Browser allows you to perform the SNMP GET, SNMP GETNEXT, SNMP GETBULK and SNMP SET operations. Besides, the software lets you capture SNMP TRAP packets sent from arbitrary SNMP devices on the network.  MIB Browser can monitor several SNMP devices simultaneously and contains features like SNMP Table viewer, logging capabilities, real-time graphical presentation of queried numerical values etc. The MIB Compiler lets you compile any vendor specific MIB file. The compiled MIB file can then be loaded and utilized by the MIB browser. Generally, a MIB file is usually supplied by the vendor of an SNMP manageable device and contains a description of the object hierarchy and object attributes on the managed device and serves as a roadmap for managing that device. 

APPARATUS

· OpenView Network Node Manager

· Compaq Network Management Software (CNMS)

· SNMPUTIL Program

· MGSoft MIB Browser

· RFC 1213

Part I             Management Information Base (MIB) In-Class Demo
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1. Locate the Select Database icon on the desktop and double click to start program.
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2. Click on Create New Database tab.
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3. Enter a database name of your choosing and then check the Make Active box. Click OK and Close the box to end the application.

                                                 
[image: image4.wmf]Cnms.lnk


4. On the desktop, select Cnms icon and click twice to start the application. During the initial startup process, CNMS will ask a series of questions to determine how you wish to use the NMA to manage the network. The following screen images will take you through the configuration process.
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5.   Select the Normal button.  Keep the check in the Show this wizard… selection and click on Next>.
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6.  Select Health Polling Only and press Next>.
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7.    The community strings should both be Public.  Press Next>.
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8.   No changes are necessary for the email entries. Press Next>.
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9.   There are no Web Based Management Modules installed so click Next>.
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10.   Select Yes and then press Next>.
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11.   Select Yes, automatically discover all of the manageable devices on my network.  Then press Finish.  The automatic discovery should start.
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12.  When it starts, you will need to provide two pieces of information.  (1) The default gateway IP address in the Gateway Router IP Address box and (2) the subnet mask in the Gateway Router Subnet Mask box.  (This information can be found on your network diagram. Ensure you use the information for your network.) Press Next>.
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13.   When the Device Discovery Wizard screen above appears, ensure that the public community string appears in the box on the right. If it does not add it and press Next>.
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14.   When the Device Discovery Wizard screen above appears, ensure that Perform Automatic Device Layout is checked and press Next>.
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15.   When the Device Discovery Wizard screen above appears, accept defaults and press Next>.
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16.   When the Device Discovery Wizard screen above appears, accept defaults and press Next>.


[image: image17.png]evice Discovery Wizard

ou must now choose the center of your layout circle. The certer coordinates are
calculated as pixels down and to the right of the top-fight comer of & map window. For
larger maps you willwantto have larger values

Adjustthe slide cantrals belowto configure the center coordinates

50 X 50

Ji

To begin the discovery process immediately, click the "Begin Device Discovery Now"
button. Otherwise click the "Next" button to enter advanced parameters

Pleset To Defaufs Beain Devics Discovery Now
<Back Next> cancel | Help |





17.   When the Device Discovery Wizard screen above appears, make sure that the sliders are set 

         to 50 X 50 by moving them to the extreme left and the extreme top of their ranges. Then 

         press Next>.
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18.   When the Device Discovery Wizard screen above appears, change the Retries value to 5, the Timeout seconds to 5, and the Network Hop Count to 5.  Press Finish.
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19.   When this dialog is presented, press OK.
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20.   Press the Details box to watch the discover process take place.
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21.  As the discovery unfolds, watch the process as the addresses change and the number of requested and completed tasks change.  The discovery will end and the software will present you with a map of the discovered network similar to the one you see below.
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22.   The “Main map shows all of the networks and subnets discovered in the discovery process.
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23.   CNMS allows you to draw lines or move icons. Click on the icon under the tools bar and move the components around to show the logical relationships. Take a few minutes to go become familiar with the remaining buttons.

                             
[image: image24.png]vain o

14751880

47 51 640
ecands,

|





24.  Now that you are in the move mode, move the components of your Main Map around to show the logical relationships.   NOTE: CNMS may not show all links.
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25.   Select "WINDOW, DISPLAY MAP".  The Show Map dialog above opens which allows you to select the map you wish to use. Click on the map you want to use and click show map. 

26.  Compare the each discovered network to the network diagrams.  Are there any differences between the two?  If so, edit your map to show the connections.

PART II

1.  On the Main map double click Router1.  Click interfaces. There you will see detailed information for the interfaces of the system. 
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2.  Close the interfaces pop up menu and click on the Protocols icon.  There you can view the different Internet and Data Link protocols supported by the device. 
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3.  Close the Protocols pop up menu and click on the System icon. There you can view and edit the writeable System Information if you have the appropriate community string.
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4.  Close the System pop up menu and click on MIB Browser. There you will be able to view the MIB Tree beginning with the Internet.     NOTE:  On many NM applications ISO (1). ORG (3) . DOD (6) will not be displayed because it's standard and will never change in a SNMP application.  When you view MIB objects, keep in mind that 1.3.6 precede the Object ID if it's not displayed by the application.  
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5.  You should have the Internet, Mgmt, and MIB-2 branches displayed.  Notice that you only have leaves on the MIB-2 branch. The presence of leaves on a branch indicates that it contain scalar information. Double Click MIB-2.

6.  There you see the standard groups in MIB-2 (RFC -1213). All NM Applications will have at a minimum RFC-1213 installed upon purchase to be in compliance with the standard. There are many more MIB objects that can be added to a NM Application, but they have to be added or compiled by the user.
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7.  Double click on the System branch. There you see the System scalar objects. The objects in blue are read/write. All others are read only. Click the System icon once to highlight the leaf objects. Click on the Table icon and Start Report. Refer to RFC 1213 as well as the following chart.
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Systems Group

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.1

System
	Group
	None
	Information about the SNMP Agents system

	1.3.6.1.2.1.1.1

sysDescr
	String to 255
	RO
	A textual description of the entity supported by this agent                                                       C, A

	1.3.6.1.2.1.1.2

sysObjectID
	Object ID
	RO
	The vendor’s OID of the agent in the entity

                                                                       C, F

	1.3.6.1.2.1.1.3

sysUpTime
	TimeTicks
	RO
	The hundredths of a second since the agent was re-initialized                                                  P, F

	1.3.6.1.2.1.1.4

sysContact
	String to 255
	RW
	The contact person for this managed node and how to contact this person                               C

	1.3.6.1.2.1.1.5

sysName
	String to 255
	RW
	An administratively assigned name for this managed node                                                   C

	1.3.6.1.2.1.1.6

sysLocation
	String to 255
	RW
	The physical location of this node

                                                                            C

	1.3.6.1.2.1.1.7

sysServices
	Integer to 127
	RW
	A value that indicates the set of services this entity offers                                               P, C, F


sysServices

	ISO Layer
	Functionality
	Value

	1
	Physical  (repeaters)
	1

	2
	Datalink / subnetwork  (bridges)
	2

	3
	Internet (IP Routers)
	4

	4
	End-to-end  (TCP support)
	8

	7
	Applications (SMTP, ect)
	64


Example:  A host that support TCP applications would have a sysServices value of 72 (8 + 64).  If it also acted as a router, the value would be 76 (4+8+64).

8.  Click X to close. Double click the System icon to collapse the system group.  Double click the Interfaces branch. There you will see a single scalar object (ifNumber) and a branch (ifTable). Double click the ifTable branch. Click the ifEntry icon once to highlight the leaf objects. Click on the Table icon at the top and Start Report. Refer to RFC 1213 and the following.

Interfaces Group

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.2

Interfaces
	Group
	None
	Information about the logical I/O ports

	1.3.6.1.2.1.2.1

ifNumber
	Integer
	RO
	The number of network interfaces present on this system                                                     C, F

	1.3.6.1.2.1.2.2

ifTable
	Sequence of

IfEntry
	None
	A list of interface entries (one each to the value of IfNumber)

	1.3.6.1.2.1.2.2.1

ifEntry
	IfEntry
	None
	Objects at the subnetwork layer and below for a particular interface                                                                          

	1.3.6.1.2.1.2.2.1.1

ifIndex
	Integer
	RO
	A unique value for each interface

                                                                           C

	1.3.6.1.2.1.2.2.1.2

ifDescr
	String to 255
	RO
	A textual string containing information about the interface                                                 C, A

	1.3.6.1.2.1.2.2.1.3

ifType
	Integer
	RO
	The type of interface, by the physical/link protocol, that is next, below the network  C, F

	1.3.6.1.2.1.2.2.1.4

ifMtu
	Integer
	RO
	The octet size of the largest datagram that can be sent or received on the interface        P, C, F

	1.3.6.1.2.1.2.2.1.5

ifSpeed
	Gauge
	RO
	An estimate of the interface’s current bandwidth in bits per second              C, A, P, F

	1.3.6.1.2.1.2.2.1.6

ifPhysAddress
	PhysAddress
	RO
	The interface’s address at the protocol layer immediately below the network              C, A, F

	1.3.6.1.2.1.2.2.1.7

IfAdminStatus
	Integer
	RW
	The desired state of the interface

                                                                       C, F

	1.3.6.1.2.1.2.2.1.8

ifOperStatus
	Integer
	RO
	The current operational state of the interface

                                                                       P, F

	1.3.6.1.2.1.2.2.1.9

ifLastChange
	TimeTicks
	RO
	The value of sysUpTime  at the time the interface entered it’s current state          P, S, F

	1.3.6.1.2.1.2.2.1.10

ifInOctets
	Counter
	RO
	The total number of octets received on the interface, including framing characters      A, P

	1.3.6.1.2.1.2.2.1.11

ifInUcastPkts
	Counter
	RO
	The number of subnetwork-unicast packets delivered to a higher layer protocol            A, P


Interfaces Group, Cont'

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.2.2.1.12

ifInNUcastPkts
	Counter
	RO
	The number of non-unicast packets delivered to a higher layered protocol                         A, P

	1.3.1.6.1.2.1.2.2.1.13

ifInDiscards
	Counter
	RO
	The number of inbound packets discarded even though no errors have been detected           P, F

	1.3.6.1.2.1.2.2.1.14

ifInErrors
	Counter
	RO
	The number of inbound errors that make packets undeliverable to a higher protocol  P, F

	1.3.6.1.2.1.2.2.1.15

ifUnknownProtos
	Counter
	RO
	The number of packets discarded because of an unknown or unsupported protocol               P, F

	1.3.6.1.2.1.2.2.1.16

ifOutOctets
	Counter
	RO
	The number of octets transmitted out of the interface, including framing characters       A, P

	1.3.6.1.2.1.2.2.1.17

ifOutUcastPkts
	Counter
	RO
	The number of packets that higher protocols requested be sent to a unicast address         A, P

	1.3.6.1.2.1.2.2.1.18

ifOutNUcastPkts
	Counter
	RO
	The number of packets that higher protocols requested to be sent to a non-unicast addr  A, P

	1.3.6.1.2.1.2.2.1.19

ifOutDiscards
	Counter
	RO
	The number of outbound packets that could not be transmitted because of errors                  P, F

	1.3.6.1.2.1.2.2.1.20

ifOutErrors
	Counter
	RO
	The number of outbound packets that could not be transmitted because of errors                  P, F

	1.3.6.1.2.1.2.2.1.21

ifOutQLen
	Gauge
	RO
	The length of the output packet queue (in packets)                                                           P, F

	1.3.6.1.2.1.2.2.1.22

ifSpecific
	Object ID
	RO
	A reference to MIB definitions specific to the media being used for the interface                  C


9.  Collapse the Interfaces branch. Double click the at branch and the atTable branch. Single click the atEntry to highlight the leaf objects.  Click on the Table icon at the top and Start Report. Refer to RFC 1213 and the following.

Address Translation Group

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.3

Address Translation 
	Group
	None
	Information from the ARP (Address Resolution Protocol) Cache

	1.3.6.1.2.1.3.1

atTable
	Sequence of AtEntry
	None
	Network address to physical address equivalence table

	1.3.6.1.2.1.3.1.1

atEntry
	AtEntry
	None
	Each entry contains one network address to physical address equivalent


Address Translation group, Cont'

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.3.1.1.1

atIfIndex
	Integer
	RW
	The interface on which this entry’s equivalent is effective                     P, F

	1.3.6.1.2.1.3.1.1.2

atPhysAddress
	PhysAddress
	RW
	The media dependent physical address

                                                  C, A, P, F

	1.3.6.1.2.1.3.1.1.3

atNetAddress
	NetworkAddress
	RW
	The network address corresponding to the media physical address     C, A, P, F


10.  Collapse the AT Group.  Double click the IP  branch. There you will notice several leaf objects and 3 tables. Single click the IP branch to highlight the leaf objects.  Click on the Table icon at the top and Start Report. Refer to RFC 1213 and the following. (The process will be repeated for the ipAddrTable, ipRouteTable, and ipNetToMediaTable.)

IP Group

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.4

IP
	Group
	None
	Information about the Internet Protocol

	1.3.6.1.2.1.4.1

ipForwarding
	Integer
	RW
	Indicates this entity can forward datagrams received by but not addressed to it  C, A, P, S, F

	1.3.6.1.2.1.4.2

ipDefaultTTL
	Integer
	RW
	The default value in the Time to Live field of the IP headers originating at this entity  C, P, F

	1.3.6.1.2.1.4.3

ipInReceives
	Counter
	RO
	The number of input datagrams received from interfaces, including those in error                  P

	1.3.6.1.2.1.4.4

ipInHdrErrors
	Counter
	RO
	The number of input datagrams discarded due to errors in their IP headers                         P, F

	1.3.6.1.2.1.4.5

ipInAddrErrors
	Counter
	RO
	The number of datagrams discarded when their IP destination was not this entity       P, F

	1.3.6.1.2.1.4.6

ipForwDatagrams
	Counter
	RO
	The number of datagrams that this entity attempted to forward                                      P

	1.3.6.1.2.1.4.7

ipInUnknownProtos
	Counter
	RO
	The number of input datagrams discarded because of an unsupported protocol         P, F

	1.3.6.1.2.1.4.8

ipInDiscards
	Counter
	RO
	The number of input datagrams that were discarded with no problems                       P, F

	1.3.6.1.2.1.4.9

ipInDelivers
	Counter
	RO
	The number of input datagrams delivered to this entity’s IP user-protocols                        P


IP Group, Cont'

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.4.10

ipOutRequests
	Counter
	RO
	The number of input datagrams that local protocols requested IP to transmit               P

	1.3.6.1.2.1.4.11

ipOutDiscards
	Counter
	RO
	The number of datagrams that were discarded with no problems                     P, F

	1.3.6.1.2.1.4.12

ipOutNoRoutes
	Counter
	RO
	The number of datagrams discarded with no route to their destination                  P, F

	1.3.6.1.2.1.4.13

ipReasmTimeout
	Integer
	RO
	The maximum number of seconds fragments are held awaiting reassembly                  C, F 

	1.3.6.1.2.1.4.14

ipReasmReqds
	Counter
	RO
	The number of fragments received that need to be reassembled at this entity                    P

	1.3.6.1.2.1.4.15

ipReasmOKs
	Counter
	RO
	The number of datagrams successfully reassembled at this entity                             P

	1.3.6.1.2.1.4.16

ipReasmFails
	Counter
	RO
	The number of failures detected by the IP reassembly algorithm                               P, F

	1.3.6.1.2.1.4.17

ipFragOKs
	Counter
	RO
	The number of datagrams that have been successfully fragmented at this entity         P

	1.3.6.1.2.1.4.18

ipFragFails
	Counter
	RO
	The number datagrams discarded because they cannot be fragmented                      P, F

	1.3.6.1.2.1.4.19

ipFragCreates
	Counter
	RO
	The number of IP datagram fragments that have been generated at this entity               P


11.  Collapse the IP Group.  Double click the ipAddrTable branch. Single click the ipAddrEntry branch to highlight the leaf objects.  Click on the Table icon at the top and Start Report. Refer to RFC 1213 and the following. 

IP Address Table

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.4.20

ipAddrTable            
	Sequence of IpAddrEntry
	None
	The table of addressing information relevant to this entity’s IP addresses 

	1.3.6.1.2.1.4.20.1

ipAddrEntry
	IpAddrEntry
	None
	The addressing information for one of this entity’s IP addresses 

	1.3.6.1.2.1.4.20.1.1

ipAdEntAddr
	IpAddress
	RO
	The IP address to which this entry’s addressing information pertains          P


IP address Table, Cont'

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.4.20.1.2

ipAdEntIfIndex
	Integer
	RO
	The value that uniquely identifies the interface to which this entry applies                                                                   

	1.3.6.1.2.1.4.20.1.3

ipAdEntNetMask
	IpAddress
	RO
	The subnet mask associated with the IP address of this entry                          C, F

	1.3.6.1.2.1.4.20.1.4

ipAdEntBcastAddr
	Integer
	RO
	The least significant bit in the IP broad-cast address used on the interface    C, F

	1.3.6.1.2.1.4.20.1.5

ipAdEntReasmMaxSize
	Integer to 65535
	RO
	The largest IP datagram that this entity can re-assemble from IP frags     C, P, F


12.   Collapse the ipAddrTable.  Double click the ipRouteTable branch. Single click the ipRouteEntry branch to highlight the leaf objects.  Click on the Table icon at the top and Start Report. Refer to RFC 1213 and the following. 

IP Route Table

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.4.21

ipRouteTable
	Sequence of IPRouteEntry
	None
	This entity’s IP routing table

	1.3.6.1.2.1.4.21.1

ipRouteEntry
	IpRouteEntry
	None
	A route to a particular destination

	1.3.6.1.2.1.4.21.1.1

ipRouteDest
	IpAddress
	RW
	The Destination IP address of this route                         

                                                                C, F 

	1.3.6.1.2.1.4.21.1.2

ipRouteIfIndex
	Integer
	RW
	The local interface through which the next hop should be reached                         C, F

	1.3.6.1.2.1.4.21.1.3

ipRouteMetric1
	Integer
	RW
	The primary routing method for this     route                                                     C, P, F

	1.3.6.1.2.1.4.21.1.4

ipRouteMetric2
	Integer
	RW
	An alternate routing method for this      route                                                    C, P, F

	1.3.6.1.2.1.4.21.1.5

ipRouteMetric3
	Integer
	RW
	An alternate routing method for this      route                                                    C, P, F

	1.3.6.1.2.1.4.21.1.6

ipRouteMetric4
	Integer
	RW
	An alternate routing method for this route           

                                                            C, P, F

	1.3.6.1.2.1.4.21.1.7

ipRouteNextHop
	IpAddress
	RW
	The IP address of the next hop of this route

                                                        C, A, P, F

	1.3.6.1.2.1.4.21.1.8

ipRouteType
	Integer
	RW
	The type of route                                       C, P, F

	1.3.6.1.2.1.4.21.1.9

ipRouteProto
	Integer
	RO
	The routing mechanism through which this route was  learned                                    C, P, F


IP Route Table, Cont'
	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.4.21.1.10

ipRouteAge
	Integer
	RW
	The seconds since this route was last updated or determined to be correct                     C, P, F

	1.3.6.1.2.1.4.21.1.11

ipRouteMask
	IpAddress
	RW
	The mask to be added with the destination and compared to ipRouteDest                             C, F

	1.3.6.1.2.1.4.21.1.12

ipRouteMetric5
	Integer
	RW
	An alternate routing method for this route           

                                                                    C, P, F

	1.3.6.1.2.1.4.21.1.13

ipRouteInfo
	Object ID
	RO
	MIB definitions specific to the routing protocol responsible for this route                               C


13.   Collapse the ipRouteTable.  Double click the ipNetToMediaTable branch. Single click the ipNetToMediaEntry branch to highlight the leaf objects.  Click on the Table icon at the top and Start Report. Refer to RFC 1213 and the following. 

IP Net to Media Table

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.4.22

ipNetToMediaTable
	Sequence of IpNetToMediaEntry
	None
	Table mapping IP addresses to physical addresses 

	1.3.6.1.2.1.4.22.1

ipNetToMediaEntry
	IpNetToMediaEntry
	None
	One IP address to physical address equivalence

	1.3.6.1.2.1.4.22.1.1

ipNetToMediaIfIndex
	Integer
	RW
	The interface on which this equivalence is effective                 C, F

	1.3.6.1.2.1.4.22.1.2

ipNetToMediaPhysAddress
	PhysAddress
	RW
	The media-dependent physical address                                  C, A, P, F

	1.3.6.1.2.1.4.22.1.3

ipNetToMediaNetAddress
	IpAddress
	RW
	The IP address corresponding to the physical address                   C, A, P, F

	1.3.6.1.2.1.4.22.1.4

ipNetToMediaType
	Integer
	RW
	The type of mapping      

                                               C, A, P, F

	1.3.6.1.2.1.4.23

ipRoutingDiscards
	Counter
	RO
	The number of valid routing entry that were chosen to be discarded      P


ipNetToMediaType

	Value
	Display
	Meaning

	1
	Other
	None of the Following

	2
	Invalid identifies
	Invalid entries

	3
	Dynamic
	Dynamic mapping

	4
	Static
	Static mapping


14.  Collapse the ipNetToMediaTable and the IP Group.  Double click the ICMP branch. Single click ICMP to highlight the leaf objects.  Click on the Table icon at the top and Start Report. Refer to RFC 1213 and the following.

ICMP Group  (Inbound)

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.5

ICMP
	Group
	None
	ICMP information

	1.3.6.1.2.1.5.1

icmpInMsgs
	Counter
	RO
	The total number of ICMP messages that the entity  received                                                 P

	1.3.6.1.2.1.5.2

icmpinErrors
	Counter
	RO
	The number of ICMP messages that the entity received that had ICMP specific errors    P, F                     

	1.3.6.1.2.1.5.3

icmpInDestUnreachs
	Counter
	RO
	The number of ICMP Destination Unreachable messages received                 P, F

	1.3.6.1.2.1.5.4

icmpInTimeExcds
	Counter
	RO
	The number of ICMP Time Exceeded messages received                                       P, F

	1.3.6.1.2.1.5.5

icmpInParmProbs
	Counter
	RO
	The number of ICMP Parameter Problem messages received                                       P, F

	1.3.6.1.2.1.5.6

icmpInSrcQuenchs
	Counter
	RO
	The number of ICMP Source Quench messages received                                       P, F

	1.3.6.1.2.1.5.7

icmpInRedirects
	Counter
	RO
	The number of ICMP Redirected Messages received                                                       P, F

	1.3.6.1.2.1.5.8

icmpInEchos
	Counter
	RO
	The number of ICMP Echo (request) messages received                                  P, S, F

	1.3.6.1.2.1.5.9

icmpInEchoReps
	Counter
	RO
	The number of ICMP Echo Reply messages  received                                                           P

	1.3.6.1.2.1.5.10

icmpInTimeStamps
	Counter
	RO
	The number of ICMP Timestamp Request  messages received                                          P

	1.3.6.1.2.1.5.11

icmpInTimeStampReps
	Counter
	RO
	The number of ICMP Timestamp Reply  messages received                                          P

	1.3.6.1.2.1.5.12

icmpInAddrMasks
	Counter
	RO
	The number of ICMP Address Mask  Request  messages received                                          P

	1.3.6.1.2.1.5.13

icmpInAddrMaskReps
	Counter
	RO
	The number of ICMP Address Mask  Reply  messages received                                          P


ICMP Group  (Outbound)

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.5.14

icmpOutMsgs
	Counter
	RO
	The total number of ICMP messages that this entity attempted to send                                P

	1.3.6.1.2.1.5.15

icmpOutErrors
	Counter
	RO
	The number of ICMP messages that this entity did not send due to ICMP problems        P, F                     

	1.3.6.1.2.1.5.16

icmpOutDestUnreachs
	Counter
	RO
	The number of ICMP Destination Unreachable messages sent                                               P, F

	1.3.6.1.2.1.5.17

icmpOutTimeExcds
	Counter
	RO
	The number of ICMP Time Exceeded messages sent                                                                P, F

	1.3.6.1.2.1.5.18

icmpOutParmProbs
	Counter
	RO
	The number of ICMP Parameter Problem messages sent                                               P, F

	1.3.6.1.2.1.5.19

icmpOutSrcQuenchs
	Counter
	RO
	The number of ICMP Source Quench messages sent                                                                 P, F

	1.3.6.1.2.1.5.20

icmpOutRedirects
	Counter
	RO
	The number of ICMP Redirected Messages sent 

                                                                       P, F

	1.3.6.1.2.1.5.21

icmpOutEchos
	Counter
	RO
	The number of ICMP Echo (request) messages sent                                                              P, S, F

	1.3.6.1.2.1.5.22

icmpOutEchoReps
	Counter
	RO
	The number of ICMP Echo Reply messages sent 

                                                                   P, S, F

	1.3.6.1.2.1.5.23

icmpOutTimeStamps
	Counter
	RO
	The number of ICMP Timestamp Request messages sent                                                      P

	1.3.6.1.2.1.5.24

icmpOutTimeStampReps
	Counter
	RO
	The number of ICMP Timestamp Reply messages sent                                                      P

	1.3.6.1.2.1.5.25

icmpOutAddrMasks
	Counter
	RO
	The number of ICMP Address Mask Request messages sent                                                     P

	1.3.6.1.2.1.5.26

icmpOutAddrMaskReps
	Counter
	RO
	The number of ICMP Address Mask Reply messages sent                                                    P


15.   Collapse the ICMP Group.  Double click the TCP branch. Single click TCP to highlight the leaf objects.  Click on the Table icon at the top and Start Report. Refer to RFC 1213 and the following.

TCP Group  

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.6

TCP
	Group
	None
	Information about TCP functions

	1.3.6.1.2.1.6.1

tcpRtoAlgorithm
	Integer
	RO
	The timeout value algorithm for retransmitting unacknowledged octets                                              C                     

	1.3.6.1.2.1.6.2

tcpRtoMin
	Integer
	RO
	The millisecond minimum of the retransmission    timeout                                                                         C                     

	1.3.6.1.2.1.6.3

tcpRtoMax
	Integer
	RO
	The millisecond maximum of the retransmission timeout                                                                         C                     

	1.3.6.1.2.1.6.4

tcpMaxConn
	Integer
	RO
	The limit on the total number of TCP connections the entity can support                                C, A, P, S, F                     

	1.3.6.1.2.1.6.5

tcpActiveOpens
	Counter
	RO
	The times TCP transitioned to the SYN-SENT state from the closed state                                               A, S                     

	1.3.6.1.2.1.6.6

tcpPassiveOpens
	Counter
	RO
	The times TCP transitioned to the SYN-RCVD state from the LISTEN state                                      A, S, F                     

	1.3.6.1.2.1.6.7

tcpAttemptFails
	Counter
	RO
	The number of times TCP has not completed the SYN  handshake                                                 P, S, F                     

	1.3.6.1.2.1.6.8

tcpEstabResets
	Counter
	RO
	The times TCP has gone to CLOSED from ESTABLISHED or CLOSE-WAIT                 P, S, F                     

	1.3.6.1.2.1.6.9

tcpCurrEstab
	Gauge
	RO
	The number of TCP connections that are either ESTABLISHED or CLOSE-WAIT                P, S, F                     

	1.3.6.1.2.1.6.10

tcpInSegs
	Counter
	RO
	The total number of segments received, including those received in error                                        A, P                     

	1.3.6.1.2.1.6.11

tcpOutSegs
	Counter
	RO
	The number of segments sent, excluding those containing only retransmitted octets                A, P                     

	1.3.6.1.2.1.6.12

tcpRetransSegs
	Counter
	RO
	The total number of segments retransmitted

                                                                             A, P                     


TCP GROUP,  Cont' 

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.6.13

tcpConnTable
	Sequence of TcpConnEntry
	None
	A table containing TCP connection-specific information

	1.3.6.1.2.1.6.13.1

tcpConnEntry
	TcpConnEntry
	None
	Information about a particular current TCP connection

	1.3.6.1.2.1.6.13.1.1

tcpConnState
	Integer
	RW
	The state of this TCP connection

                                                   A, P, S, F                     

	1.3.6.1.2.1.6.13.1.2

tcpConnLocalAddress
	IpAddress
	RO
	The local IP address for this TCP connection                            C, A, P, S, F                     

	1.3.6.1.2.1.6.13.1.3

tcpConnLocalPort
	Integer to 65535
	RO
	The local port number for this TCP connection                            C, A, P, S, F                     

	1.3.6.1.2.1.6.13.1.4

tcpConnRemAddress
	IpAddress
	RO
	The remote IP address for this TCP connection                                A, P, S, F                     

	1.3.6.1.2.1.6.13.1.4

tcpConnRemPort
	Integer to 65535
	RO
	The remote port number for this TCP connection                                A, P, S, F                     

	1.3.6.1.2.1.6.14

tcpInErrs
	Counter
	RO
	The total number of segments received in error                                               P, F                     

	1.3.6.1.2.1.6.15

tcpOutRsts
	Counter
	RO
	The number of TCP segments sent containing the RST flag                    P, F                     


16.  Collapse the TCP Group.  Double click the UDP branch. Single click UDP to highlight the leaf objects.  Click on the Table icon at the top and Start Report. Refer to RFC 1213 and the following.

UDP GROUP

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.7

UDP
	Group
	None
	Information about UDP functions

	1.3.6.1.2.1.7.1

UdpInDatagrams
	Counter
	RO
	The total number of UDP datagrams delivered to UDP users                                                 A, P                     

	1.3.6.1.2.1.7.2

UdpNoPorts
	Counter
	RO
	The number of received UDP datagrams with no application at the destination port     P, S, F                     

	1.3.6.1.2.1.7.3

UdpInErrors
	Counter
	RO
	The number of received UDP datagrams with errors (not lack of application)                   P, F                     

	1.3.6.1.2.1.7.4

UdpOutDatagrams
	Counter
	RO
	The total number of UDP datagrams sent from this entity                                                      A, P                     


17.  Collapse the UDP Group.  Double click the udpTable branch. Single click udpEntry to highlight the leaf objects.  Click on the Table icon at the top and Start Report. Refer to RFC 1213 and the following.

UDP TABLE

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.7.5

udpTable
	Sequence of UdpEntry
	None
	A table containing UDP listener information

	1.3.6.1.2.1.7.5.1

UdpEntry
	UdpEntry
	None
	Information about a particular current UDP listener

	1.3.6.1.2.1.7.5.1.1

UdpLocalAddress
	IpAddress
	RO
	The local IP address for this UDP listener                

                                                      C, A, P, S, F                     

	1.3.6.1.2.1.7.5.1.2

UdpLocalPort
	Integer to 65535
	RO
	The local port number for this UDP listener                

                                                      C, A, P, S, F                     


18.  The EGP Group is obsolete. The Transmission Group has no leaves so it is empty. In order to see anything in the Transmission Group, a MIB must be compiled or added to the NMS. (We will do this later).

19.   Collapse the UDP Group.  Double click the SNMP branch. Single click SNMP to highlight the leaf objects.  Click on the Table icon at the top and Start Report. Refer to RFC 1213 and the following.

SNMP GROUP

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.11

SNMP
	Group
	None
	Objects to manage SNMP functions

	1.3.6.1.2.1.11.1

snmpInPkts
	Counter
	RO
	The number of messages delivered to the SNMP entity                           A, P

	1.3.6.1.2.1.11.2

snmpOutPkts
	Counter
	RO
	The number of messages passed from the SNMP protocol entity             A, P

	1.3.6.1.2.1.11.3

snmpInBadVersions
	Counter
	RO
	The message delivered with an unsupported SNMP Version         S, F

	1.3.6.1.2.1.11.4

snmpInBadCommunityNames
	Counter
	RO
	The message delivered with an unsupported SNMP Version     P, S, F

	1.3.6.1.2.1.11.5

snmpInBadCommunityUses
	Counter
	RO
	The message delivered with a task the community name prevents        P, S, F


SNMP Group, Cont'

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.11.6

snmpInASNParseErrs
	Counter
	RO
	The ASN.1 or BER errors found when decoding received messages P, F

	1.3.6.1.2.1.11.7

unused
	Counter
	RO
	Not used

	1.3.6.1.2.1.11.8

snmpInTooBigs
	Counter
	RO
	The PDUs delivered with an error-status value of tooBig                     P, F

	1.3.6.1.2.1.11.9

snmpInNoSuchNames
	Counter
	RO
	The PDUs delivered with an error-status value of noSuchName         P, F

	1.3.6.1.2.1.11.10

snmpInBadValues
	Counter
	RO
	The PDUs delivered with an error-status value of badValue               P, F

	1.3.6.1.2.1.11.11

snmpInReadOnlys
	Counter
	RO
	The PDUs delivered with an error-status value of readOnly              P, F

	1.3.6.1.2.1.11.12

snmpInGenErrs
	Counter
	RO
	The PDUs delivered with an error-status value of genErr                  P, F

	1.3.6.1.2.1.11.13

snmpInTotalReqVars
	Counter
	RO
	The number of MIB objects  success-fully retrieved by the entity              P

	1.3.6.1.2.1.11.14

snmpInTotalSetVars
	Counter
	RO
	The number of MIB objects success-fully altered by the entity              P, S

	1.3.6.1.2.1.11.15

snmpInGetRequests
	Counter
	RO
	The number of GetRequest PDUs accepted and processed by the entity   P

	1.3.6.1.2.1.11.16

snmpInGetNexts
	Counter
	RO
	The number of GetNext PDUs accept-ed and processed by the entity          P

	1.3.6.1.2.1.11.17

snmpInSetRequests
	Counter
	RO
	The number of SetRequest PDUs accepted and processed by the entity  S

	1.3.6.1.2.1.11.18

snmpInGetResponses
	Counter
	RO
	The number of GetResponse PDUs accepted and processed by the entity   P

	1.3.6.1.2.1.11.19

snmpInTraps
	Counter
	RO
	The number of Trap PDUs accepted and processed by the entity       P, S, F

	1.3.6.1.2.1.11.20

snmpOutTooBigs
	Counter
	RO
	The number of PDUs sent with an error-status field of tooBig            P, F

	1.3.6.1.2.1.11.21

snmpOutNoSuchNames
	Counter
	RO
	The PDUs generated with an error-status field of noSuchName              P, F

	1.3.6.1.2.1.11.22

snmpOutBadValues
	Counter
	RO
	The PDUs generated with an error-status value of badValue                  P, F

	1.3.6.1.2.1.11.23

unused
	Counter
	RO
	Not used


SNMP Group, Cont'

	OID & Name
	Syntax
	Access
	Description and ISO Areas

	1.3.6.1.2.1.11.24

snmpOutGenErrs
	Counter
	RO
	The PDUs generated with an error-status value of genErr                      P, F

	1.3.6.1.2.1.11.25

snmpOutGetRequests
	Counter
	RO
	The number of GetRequest PDUs generated by the SNMP entity              P

	1.3.6.1.2.1.11.26

snmpOutGetNexts
	Counter
	RO
	The number of GetNext PDUs generated  by the SNMP entity             P

	1.3.6.1.2.1.11.27

snmpOutSetRequests
	Counter
	RO
	The number of SetRequest PDUs generated  by the SNMP entity         P, S

	1.3.6.1.2.1.11.28

snmpOutGetResponses
	Counter
	RO
	The number of GetResponse PDUs generated by the SNMP entity              P

	1.3.6.1.2.1.11.29

snmpOutTraps
	Counter
	RO
	The number of Trap PDUs generated by the SNMP entity                       P, S, F

	1.3.6.1.2.1.11.30

snmpEnableAuthenTraps
	Counter
	RW
	If set, the agent is permitted to generate authentication-failure traps     C, P, S, F


20.  Collapse the SNMP Group.  Double click the TRAPS branch. Note the Traps that are available with this version of SNMP.
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PART II          Management using Command Line SNMP            PE 9a

1.  In this section, you will begin your exploration of SNMP and it’s MIBs.  You will be querying the network using the Command Line SNMP Utility that is part of the Windows Operating System.  This program will allow you to see, on a basic level, how the different machines are talking to each other and the commands they use. 

           a)   SNMPGET - Allows the user to retrieve a single MIB object from an Agent.

           b)  SNMPGETNEXT - Allows a user to get the next object following a given object from

                an Agent. This is used if you are unsure or do not know what object is next.      

           c)  SNMPWALK - Displays the contents of the entire MIB in one request. Because of it's 

                size, it can be directed to a disk file and viewed later. It is normally used to verify 

                exactly what management information an agent will support versus what the 

               documentation from the vendor say it will support. 

2.  SNMP Command Line functions are commonly found in most network management software     implementations. They can also be found in Freeware and software form provided on your CD and on the internet. They can be used to gather management information when you don't have access to a NMS.  

3.  Let's get started.

a)   Record the name and IP address of your workstation below.


(Start > Programs > Accessories > Command Prompt > cd winnt\system32> enter


> ipconfig  /all)

Host Name:  _______________________________________________

IP Address:  _______________________________________________

b)   Log onto the workstation with using the following:


(Ask Instructor)

       Username:   _______________________________________________

       Password:   _______________________________________________
4.  Customize your workstation.

            a)  Click on  the Start  button and select Settings > Control Panel. Double click on 

           Administrator Tools  > Services.  Scroll down and double click SNMP Service. Select the 

           Agent tab and add the following information:

            b)  Contact:         Your Name                           .

            c)   Location:          TSEC LAB                        .

            d)  After entering you information, click on Apply and then OK.  Close all open windows.

5.  Start a Command Prompt window. (Start > Programs > Accessories > Command Prompt)

a) You will now use the command-line SNMP manager to find the system contact for 6 of the other machines in the classroom.  To do this, you will use an SNMP get – request.  The general syntax is as follows:

snmputil get {host} {community} {object identifier}

snmpget {host} {community} {object identifier}


      where: 
{host} is the hostname or IP address of the target;




{community} is the simple authentication name; and




{object identifier} is the object name you wish to retrieve.

b) The command line interpreter assumes you are retrieving an object from mib-2, unless the object identifier starts with a “.”.  Also, object names are case sensitive.  For example, to retrieve the value of the object sysDescr from device student1, type the following command:

snmputil get {ip address} student1 public system.sysDescr.0


 
What Information did you get?

 
__________________________________________________________


Now type the command without the .0.

snmputil get {ip address} student1 public system.sysDescr

What information did you get?

_________________________________________________________

   ** As you can see, the ".0" is required on the request for this object. The ".0" part of the Object  

        Identifier is called an Instance Identifier. It is used to request instances for object that are

        not a part of a table. This will be discussed in more detail in Lecture 4.

 Now try some other naming conventions:

snmputil get {ip address} student1 public .iso.org.dod.internet.mgmt.mib-2.system.sysDescr.0

snmputil get {ip address} student1 public .1.3.6.1.2.1.1.1.0

snmputil get {ip address} student1 public system.1.0

c) Now let's look at how we can retrieve specific objects from a table.

                Enter the following command:

                        snmputil get {ip address} router1 public ifType.1

                What information did you discover about Router1 and it's first physical interface?

                __________________________________________________

                Enter the following command:

                       snmputil get {ip address} router1 public ifType.2

                What information did you discover about Router1 and it's second physical interface?

                _________________________________________________

                Enter the following command:

                        snmputil get {ip address} router1 public ifType.0

                 What happened this time?

                 ________________________________________________

                 (As you can see, the instance ".0" cannot be used to retrieve objects from a table)

                 Rather than use the object name you can also use the object number to retrieve

                 information. To retrieve the interface type of the first interface enter the following 

                 command:

                       snmputil get {ip address} router1 public .1.3.6.1.2.1.2.2.1.2.1 

                  What information did you discover about router1 and it's first interface?

                  _________________________________________________________

            d)  Fill in the sysContact Table below using the SNMP command-line manager for a 

minimum of 6 Host. For example, to retrieve the value of the object sysContact from 

device switch1, type the command:

                          snmputil get {ip address} switch1 public system.sysContact.0

                  (Note:  If you do not receive a response or if you receive an error "464" then the 

                   system you queried have not been set up.)

	Host Name
	Ip Address
	System Contact

	Student1
	
	

	Student2
	
	

	Student3
	
	

	Student4
	
	

	Student5
	
	

	Student6
	
	

	Student7
	
	

	Student8
	
	

	Student9
	
	

	Student10
	
	

	Student11
	
	

	Student12
	
	

	Student13
	
	

	Student14
	
	

	Student15
	
	

	Switch1
	
	

	Switch2
	
	

	Switch3
	
	

	Router1
	
	

	Router2
	
	

	Router3
	
	

	Server1
	
	


6.  Using the SNMP getnext command.

            a)  Next you will use the SNMP command getnext to query MIB objects in a table 

                 without knowing the exact object identifier for the first entry in the table.  This 

                 command uses the same general syntax as the get request.  However, it returns with 2 

                 objects: variable and value.  The Variable field is actually the address of the next sub-

                 layer to your input {host} and the Value is the value of that next layer.  For example, 

                 to the retrieve the object after sysUpTime type the following commands: 

          snmputil getnext {ip address} student1 public system.sysUpTime.0

         snmputil getnext {ip address} student1 public .1.3.6.1.2.1.1.3.0


     The following information should have been returned for both:

     _______________________________________________
 b) Use the response from the getnext command to retrieve the next entry in the table 

      using getnext.

      Example: If you received the above response, you would retrieve the next entry by 

      typing:

          snmputil getnext {ip address} student1 public  {response OID}
      What information was returned?

      _______________________________________________

7.  Extended capabilities are built into this SNMP interface so that you do not have to type in long strings of get and getnext requests to access information.  Once such command is the walk that issues all the getnext commands required to read the specified branch of the MIB.  

            a)  Retrieve the routing table of your workstation by typing:

snmputil walk {ip address} router1 public ip.ipRouteTable

                 You should have received the entire routing table.

            b)  Enter the following command.

                        snmputil walk {ip address} router1 public ip.ipRouteTable > walkout

                  When it completes enter the following:

                   Click Start > Run. Enter walkout and press ok. Open with Notepad and press ok. 

                   You should be able to scroll though the saved routing table. 

          c)  Instead of viewing one table at a time, you can view the entire MIB (Public and 

               Private). Enter the following command:

                          snmpwalk {ip address} router1

              You should be able to observe all the MIB information scrolling across the screen.

               Now send the output to a file by entering the following command:  

                         snmpwalk {ip address} router1 > walkout

               You will not observe anything scrolling across the screen but you can view it by 

               opening the walkout file using the procedures in "b)" above.

8.  Common Command Line Options
Usage :  snmpwalk   [options…]   < hostname >    {community >}    [objected >]

UCD - snmp  version: 4.1.1


-h
this help message


-H
Display configuration file directives understood


-V
display version number


-v 1|2c|3
specifies which snmp version to use


Version 1 or 2c specified


-c  <c>
set the community name (v1 or v2c)


Version 3 specific


-Z  <B>  <T>
set the destination engine boots/time for v3 requests


-e  <E>
security engine ID   (e,g., 65000000005463…..)


-E  <E>
context engine ID  (e,g., 65000000102….)


-n  <N>
context name  (e.g.,  bridge1)


-u  <U>
security name  (e.g., bert)


-l  <L>
security level  (noAuthNoPriv|authNoPriv|authPriv)


-a  <A>
authentication protocol  (MD5|SHA)


-A  <P>
authentication protocol pass phrase.


-x  <X>
privacy protocol  (DES)


-X  <P>
privacy protocol pass phrase


General communication options


-p  <P>
use port P indtead of the default port


-T  <layer>
use LAYER for the network layer

                                                    (UDP or TCP)



-t  <T>
set the request timeout to T.


-r  <R>
set the number of retries to R

PART III                          MG Soft MIB Browser                            PE 9b

1.  In this section, you will explore how MG SOFT’s software deals with SNMP and MIBs.  This software, internally, is performing the same actions and utilizing the same commands that SNMPUTIL was, but it has a nice Graphical Interface.  
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a) Start the MG-Soft MIB Browser application by double clicking MIB Browser on the desktop. Once it opens, make sure that your machine’s IP address is listed in the Remote Agent Dialog box.  (Your machine’s IP address is located on the attached network info sheet.)
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b) Maximize the MG SOFT MIB Browser window.  Select Tools | Discovery Window.  Click the top left-hand button to discover all of the hosts of you subnetwork. (This could take several minutes.)
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c) For each discovered host, right-click on the system name and select IP to History List.   When you have finished, close the SNMP Agent Discovery window.  
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d) In the MIB Tree pane, expand the branches as follows:

iso | org | dod | internet | mgmt | mib-2

e) Now, before you can retrieve information from an SNMP agent with MG-Soft MIB Browser, you must first contact the agent.  Right Click on the system branch and select Contact.  This will give you the value of the sysUpTime object in the Query Results pane.  

f) Right click on the system branch again and select walk.  

                  What is the System Uptime of your workstation?

                   __________________________________________

                  What is the System Services of your workstation? What does it mean?

                  ___________________________________________________________________


___________________________________________________________________
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g) From the Remote SNMP Agent pull-down, select the IP address of your local switch.  Expand the IP Branch in the MIB Tree pane. Right-click on the ipNetToMediaTable branch and select Contact.  

h) Right-click the ipNetToMediaTable branch again and select Table View.  The table now displayed is the ipNetToMediaTable from the ip branch of MIB-II.  

                  What is your Ethernet physical address?

                  ________________________________________
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i) Now we will read the same information by walking through the MIB tree.  Close the Table window.  Expand the ipNetToMediaTable branch.  Expand the ipNetToMediaEntry branch.  Right-click the ipNetToMediaTable branch and select Walk. Compare these objects with the table you saw in the previous part of this exercise.  

Part IV                  Management using HP OpenView                       PE 9c

1.  In this section, you will review the basics of SNMP through the use of HP OpenView Network Node Manager Software.  One way to discover nodes on a network segment is to conduct a physical inspection of the network. This process becomes too cumbersome and impractical for large networks (especially when they span a large distance) unless it is done at the time of network setup or the planning stage.  OpenView allows you to easily document your network.  

2.  HP OpenView creates a Root submap that serves as an anchor on which an application can place a “root” symbol.  Symbols on the Root submap can open submaps that show the top-level view of a specific network, such as an IP Internet or an OSI network.  When a map is created, IP Map creates the following submap hierarchy, showing the network in increasing detail:  Internet submap, Network submaps, Segment submaps, and Node submaps.  IP Map only manages objects that exist within this hierarchy of submaps.  IP Map will not manage the objects of symbols added to the Root submap, or added outside the realm of the IP submap hierarchy.
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a) 
Make sure you are still logged into the workstation.  Install the HP OpenView  

    
software by double clicking the  nnm62nteval  icon on the desktop.

         
[image: image40.png]inip Self-Extractor - nnmb2nteval.exe:

2 This program s for Evaluston Purposes oy, Ses
i s cpenien hp con/Seetybuy/bu for

purchase inomaton.
Press "Setup” to beain instaling HP Dperiview Network Cancel

Node Manager Evalustion Version 6.2
About





b)
Press Setup.
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c)
Enter ovnnm as the password.
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d)
Press Setup to unzip files when this screen appears.
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e)
Click Next>
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f)
Click Yes.
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g)
Enter Student Name and TSEC for company name.  Click Next>.
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h)
Accept defaults. Click Next>.
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i)
Select the Typical button and the Next>.
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k)
Click Next>.
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l)
Click Yes.
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m)
Accept default and click Next>.
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n)
Click Next> and wait for HP OpenView to install.
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o)
Uncheck Examine Release Notes (README) and click Finish.
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p)
Click Cancel.
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q)
Once NNM is opened there are two ways to navigate through the submaps in 

OpenView. One way is by double clicking on the icons (to go deeper) or the up 

arrow on the toolbar (to rise to the top level).  At each stage, configuration 

information about the icon can be found through the Edit Menu or Properties Button.

The other way is to go directly to the desired submap by using the “Open Submaps...”

option under the Window Menu. Try both ways of moving around.

r)
Open the next submap by double clicking the Internet icon.
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s)
A window will appear similar to this window.  Highlight the icon for IP 147.51.239 


by clicking it once. Then select Edit > Manage Objects.  Next, double click the


147.51.239 icon to display the next submap.
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t)
Double click the Segment1 icon.
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u) 
Highlight one of the icons by clicking it once. Select Tools > SNMP MIB Browser.  


Ensure the system information is present in the appropriate windows and expand the MIB 


Tree.

               What's the IP Address, Name, System Uptime, and Description of the workstation


you selected? 

               _________________________________________________________________


_________________________________________________________________


_________________________________________________________________
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d) Now choose to look at a MIB value that also has the ability to graph the information.  

    Once that title is highlighted, click on the graph button.  If you need a precise time 

    from the graphical information, left click anywhere on the graph and hold the button as 

    you move the pointer.  This will display the time value associated with the information 

    under the pointer.  

3.  Trap Configuration and Analysis.  Traps can be caused by abnormal conditions in 

 your managed devices or by activity caused by managers or "Hackers". In this exercise you 

 will learn how to modify HP OpenView to gain a better understanding of various traps.

 a) From the main HPOV screen, select the Options menu and then select Event 

 Configuration.
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     b) Scroll down and select  snmpTraps.

     c) Highlight SNMP_Link_Down, select Edit > Events > New.

     d) Change the event name to Link_Down. Click the Generic Trap dropdown box and 

          select Link Down.  Select Next>
     e) Select All Sources and click next >.
                  f) Actions Selection: Select Log and display in category > Error Alarms.  Change the

                    Severity of the trap to Major. Select Next>.
                g) 
Select Next>.
                h) 
Select Next>.
                i) 
Select Finish. Your trap is now configured.

                j) 
Repeat steps c) through I) to configure the following:

                    
Event: Link Up
                    
Generic Trap:  Link Up
                    
Severity: Minor
                k) 
When you are finished adding the events select File > Save. Then select 

                    
File > Close.
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                l) 
To view traps, click on Error Alarms in your Alarm Categories display.

m)
Go to Options, then Report Configuration.  This will open up a new window in 

which you can generate various network reports to be emailed.  (If this report editor 

fails to load, check your internet connection and return to this question later).  Choose a 

               relevant category in the window and have the software send you a report on the status 

               of the network.  Spend a little bit of time scrolling through this feature.


n)
Spend a little time exploring the different menus with NNM. We will work more 


with NNM during the Tactical Network Management session.

Part V                 SNMP Protocol Data Units                             PE 9d

1.  In this section, you will use Ethereal to view SNMP Protocol Data Units. Ethereal is a GUI network protocol analyzer. It lets you interactively browse packet data from a live network or from a previously saved capture file.  Like other protocol analyzers, Ethereal's main window shows 3 views of a packet. It shows a summary line, briefly describing what the packet is. A protocol tree is shown, allowing you to drill down to exact protocol or field that you interested in. Finally, a hex dump shows you exactly what the packet looks like when it goes over the wire.
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a) 
Close any running SNMP application and start Ethereal by double-clicking it's icon on the desktop.
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b) 
Once the Ethereal Network Analyzer Window appears, select Capture>Start.
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c)
Once the "Ethereal: Capture Options" window appears, select the following: 

       1) Capture Packets in promiscuous mode

       2) Update list of packets in real time
       3) Automatic scrolling in live capture
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d)
Enter UDP Port 161 as the "Filter:" and click ok.  Wait on the instructor to generate some SNMP traffic. You should start to see SNMP packets accumalate on the Ethereal: Capture window. 


1) When told to do so, stop the capture by clicking Stop in the Ethereal: Capture 


Window)
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e)
Once the window above appears, select File > Save As and enter c:\capture as the filename.

f)
Select packet number 10 and answer the following questions.

    
1) 
What type of SNMP PDU is utilized for this capture?


_________________________________________


2)
What's the length of the Ethernet Frame transmitted, in octets?




_________________________________________


3)
What's the UDP Source and Destination Port?



_________________________________________


4)
What is the Object Identifier?



__________________________________________


5)
What is the Value? Explain.



___________________________________________________________________



___________________________________________________________________



___________________________________________________________________



___________________________________________________________________


6)
What is the community name for the PDU and what version of SNMP is used?



_________________________________________________

Part VI                 Remote Monitoring (Traffic Monitor)                    PE 9e

LAB OBJECTIVE

This Practical Exercise familiarizes the student with the Remote Monitoring (RMON) Management Information Base (MIB) extensions to Simple Network Management Protocol (SNMP) and allow them to gain an understanding of how RMON can be used in network management.  The student will accomplish this by examining the network with the aid of several RMON MIB elements.

INTRODUCTION

As TCP/IP networks evolved and grew through the late 80's and early 90's, network management became an issue of concern.  In the early 90's, the IETF developed SNMP and MIB I.  MIB I defined information that could be gathered on network components, but did not give a view of what was happening on the local area network segment.  Yet as the complexity of networks increased, merely gathering information on the status of the pieces of the network did not provide sufficient information.

RMON 1

The RMON standard, originally designated as IETF RFC 1271 (then RFC 1757, now RFC 2518 — Internet Standard 59), was designed to provide proactive monitoring and diagnostics for distributed LAN-based networks. Monitoring devices, called probes, enable an effective means of instrumenting critical network segments for user-defined alarms and a wealth of vital statistics. The RMON standard divides monitoring functions into nine groups to support Ethernet topologies.  The RMON standard was crafted to support a distributed computing architecture, where the probes communicate with a central management station (a client) via Simple Network Management Protocol (SNMP). These probes have defined SNMP Management Information Base (MIB) structures for all RMON groups, allowing interoperability between vendors of RMON-based diagnostic tools.

RFC 2518 defines five goals for RMON 1

· Offline Operation —   There are sometimes conditions when a management station will not be in constant contact with its remote monitoring devices.  This is sometimes by design in an attempt to lower communications costs (especially when communicating over a WAN or dialup link), or by accident as network failures affect the communications between the management station and the probe. For this reason, the RMON MIB allows a probe to be configured to perform diagnostics and to collect statistics continuously, even when communication with the management station may not be possible or efficient.  The probe may then attempt to notify the management station when an exceptional condition occurs.  Thus, even in circumstances where communication between management station and probe is not continuous, fault, performance, and configuration information may be continuously accumulated and communicated to the management station conveniently and efficiently.

· Proactive Monitoring — Given the resources available to the RMON probe, it  is potentially helpful for it continuously to run diagnostics and to log network performance.  The probe is always available at the onset of any failure.  It can notify the management station of the failure and can store historical statistical information about the failure.  This historical information can be played back by the management station in an attempt to perform further diagnosis into the cause of the problem.

· Problem Detection and Reporting — The probe can be configured to recognize conditions, most notably error conditions, and continuously to check for them.  When one of these conditions occurs, the event may be logged, and management stations may be notified in a number of ways.

· Value Added Data — Because a remote monitoring device represents a network resource dedicated exclusively to network management functions, and because it is located directly on the monitored portion of the network, the remote network monitoring device has the opportunity to add significant value to the data it collects. For instance, by highlighting those hosts on the network that generate the most traffic or errors, the probe can give the management station precisely the information it needs to solve a class of problems.

· Multiple Managers — An organization may have multiple management stations for different units of the organization, for different functions (e.g. engineering and operations), and in an attempt to provide disaster recovery.  Because environments with multiple management stations are common, the remote network monitoring device has to deal with more than own management station, potentially using its resources concurrently.

Network managers can collect information from remote network segments with RMON probes for the purposes of troubleshooting and performance monitoring. The RMON 1 MIB definition provides:

· Current and historical traffic statistics for a network segment, for a specific host on a segment, and between hosts (matrix)

· A versatile alarm and event mechanism for setting thresholds and notifying the network manager of changes in network behavior

· A powerful, flexible filter and packet capture facility which can be used to deliver a complete, distributed protocol analyzer
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The figure below shows a listing of the RMON1 groups.  The RMON 1 MIB is an extension to the IETF MIB II with a subtree identifier of 16.

RFC 2518 defines the ten groups as:

The Ethernet Statistics Group — The ethernet statistics group contains statistics measured by the probe for each monitored Ethernet interface on this device.  This group consists of the etherStatsTable.  

The History Control Group — The history control group controls the periodic statistical sampling of data from various types of networks.  This group consists of the historyControlTable.

The Ethernet History Group — The ethernet history group records periodic statistical samples from an ethernet network and stores them for later retrieval.  This group consists of the etherHistoryTable.

The Alarm Group —  The alarm group periodically takes statistical samples from variables in the probe and compares them to previously configured thresholds. If the monitored variable crosses a threshold, an event is generated. A hysteresis mechanism is implemented to limit the generation of alarms.  This group consists of the alarmTable and requires the implementation of the event group.

The Host Group — The host group contains statistics associated with each host discovered on the network.  This group discovers hosts on the network by keeping a list of source and destination MAC Addresses seen in good packets promiscuously received from the network.  This group consists of the hostControlTable, the hostTable, and the hostTimeTable.

The HostTopN Group — The hostTopN group is used to prepare reports that describe the hosts that top a list ordered by one of their statistics.  The available statistics are samples of one of their base statistics over an interval specified by the management station.  Thus, these statistics are rate based.  The management station also selects how many such hosts are reported.  This group consists of the hostTopNControlTable and the hostTopNTable, and requires the implementation of the host group.

The Matrix Group —  The matrix group stores statistics for conversations between sets of two addresses.  As the device detects a new conversation, it creates a new entry in its tables.  This group consists of the matrixControlTable, the matrixSDTable and the matrixDSTable.

The Filter Group —  The filter group allows packets to be matched by a filter equation. These matched packets form a data stream that may be captured or may generate events.  This group consists of the filterTable and the channelTable.

The Packet Capture Group — The Packet Capture group allows packets to be captured after they flow through a channel.  This group consists of the bufferControlTable and the captureBufferTable, and requires the implementation of the filter group.

The Event Group —  The event group controls the generation and notification of events from this device.  This group consists of the eventTable and the logTable.

RMON implementations are generally delivered as a two-part client/server solution. The “client” is the application that runs on the network management station and presents the RMON information to the user. The “servers” are the RMON probes distributed throughout the remote networks that collect the RMON information and analyze network packets. RMON probes can be found in dedicated devices and/or embedded in network infrastructure devices such as hubs and switches. The management station and the probe communicate across the network using the Simple Network Management Protocol (SNMP).

RMON is designed so that the data collection and processing is done by the probe. This reduces the SNMP traffic on the network and the processing load on the management station. Instead of continuous polling, information is only transmitted to the management station when required. Many RMON “client” applications (management stations) located in various parts of the network can simultaneously communicate with and get information from one RMON “server (probe).” The information from a single RMON probe can be used for many tasks, from troubleshooting and protocol analysis to performance monitoring and capacity planning.  RMON1 provides valuable statistics on the whole network segment. Other SNMP management products focus on monitoring a specific network device. While device-specific management tools are important, they do not provide a picture of the health of the whole network segment with all its devices, servers, applications, and users.

RMON 2

Distributed computing architectures are built upon the principle that users and resources are not required to be on the same physical LAN segment. Any user with the correct privileges can access any remote computing resource in the network. Today, these enterprise networks are comprised of multiple LAN segments and rings connected by routers and switches. A drawback of “RMON 1”-based probes is that because they view the traffic on the local LAN segment, they are not able to identify network hosts and sources beyond the router connection. To do so, a probe must be capable of identifying traffic at the network layer that will provide statistics for all hosts accessing that segment, no matter where they are located or how the network is connected.  With RMON 2-based agent, all RMON 2 groups map into all of the major network-layer protocols such as IP, International Packet Exchange (IPX), DECnet, AppleTalk, and Banyan VINES, giving a complete end-to-end view of network traffic.

In addition, RMON2 defines the specification for monitoring application-layer traffic, which enables administrators to monitor network applications such as Notes, Telnet, Microsoft Mail, Sybase, and others by outlining how logical filters can be constructed for probes. With this capability, network managers can proactively monitor and troubleshoot any key application-layer traffic within the enterprise network. RMON alarms, statistics, history, and host/conversation groups are now usable for troubleshooting and maintaining network availability based upon application-layer traffic—the most critical traffic in the network.

RMON 2 adds the following key enhancements:

· Network-layer host and matrix tables for monitoring layer 3 traffic by host, by conversations for various protocols, and for the standard RMON attributes such as utilization, packet rate, errors, and others.

· Application-layer host and matrix tables for monitoring layer 7 traffic by host, by conversations for various applications, and for the standard RMON attributes such as utilization, packet rate, and errors.

· Network address mapping for aggregating the statistics by network address as well as MAC address for Ethernet and Token Ring networks.

· Protocol Directory and Distribution groups for displaying selected protocols and their distribution for each LAN segment.

· User-definable history, which now extends beyond RMON1 link-layer statistics to include any RMON1, RMON2, MIB-I or MIB-II statistics

· Other enhancements include the definition of methods for remotely maintaining and configuring probes for trap messages, modem communications, and software updates.

Work on an extension to the RMON 1 MIB specification began in 1994.  In 1997, the IETF published RFC RFC 2021, Remote Network Monitoring Management Information Base II and  RFC 2074, Remote Network Monitoring MIB Protocol Identifiers.  These specifications became known as RMON 2.  RMON 2 extends the RMON MIB by defining nine new MIB groups (RFC 2021)

· Protocol Directory Group — Lists the inventory of protocols the probe has the capability of monitoring and allows the addition, deletion, and configuration of entries in this list.

· Protocol Distribution Group — Collects the relative amounts of octets and packets for the different protocols detected on a network segment.

· Address Map Group — Lists MAC address to network address bindings discovered by the probe and what interface they were last seen on.

· Network Layer Host Group — Counts the amount of traffic sent from and to each network address discovered by the probe.

· Network Layer Matrix Group — Counts the amount of traffic sent between each pair of network addresses discovered by the probe.

· Application Layer Host Group — Counts the amount of traffic, by protocol, sent from and to each network address discovered by the probe.

· Application Layer Matrix Group — Counts the amount of traffic, by protocol, sent between each pair of network addresses discovered by the probe.

· User History Collection Group — The usrHistory group combines mechanisms seen in the alarm and history groups to provide user-specified history collection,

· The Probe Configuration Group — This group controls the configuration of various operating parameters of the probe.

Procedures 

Software Tools:

MG-SOFT MIB Browser Professional Edition 6.10.0.3633

Cisco TrafficDirector v5.8.3a 


Cisco Catalyst 2924XL with Mini-RMON Probe


EtherReal

Mini-RMON---A RMON probe is provided with and active by default on Cisco switches.  The Cisco RMON Probe is known as a mini-RMON since it utilizes a limited subset of the RMON MIB. Mini-RMON allows for the monitoring of every port on the switch for base-level statistics at the Media Access Control (MAC) layer. The four groups existing in mini-RMON include Statistics, History, Alarms, and Events.

Defining an RMON Probe using MG-SOFT

a)  
Determine the ifIndex for your system. The ifIndex is the unique value used to identify each interface.  You must determine the ifIndex for the interface you are connected to.  
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1)
Start MG-SOFT MIB Browser by double clicking the MIB Browser Icon on your 


desktop.
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2)
Once the MG-SOFT MIB window appears Click the MIB TAB. Verify whether or not


the RMON MIB is loaded in the MIB browser. If it appears in the upper portion of the 


window go to step 4. If not go to the next step.
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3)
Highlight the RMON-MIB from the lower window and depress the Red Up Arrow. This will load the RMON-MIB into your MIB browser.

[image: image82.png]Domains

Logging
tats: [Enable =] [5 Hinates =]

Hosts: [Disablex] [Disable =]
Conversations: [Disable ¥ [Disable ]
Response Time: [Disablo ] [Disable =]

I¥ Shot-Tem History: [50  samples [30  seconds

' Long-Term History: [S0 samples [1800  seconds

o | ETBR Concel |





[image: image83.png]Ble Password Toos Help

=lolx]

& Domain

 Agent ( AgentGroup ( Switch ( FrameRelay

€ RT Delay € Piowy SHMP.

Nane

P aaress Add.

Edit

ik

Properties File: fwSpiop.

& Shared (' Custom

Download.
Rove ON
Rove OFF

i

| | S S ,
o || [ — —— -
e |




[image: image84.png]MG-SOFT MIB Browser Professional Edition =18 x|
REERTCIHEEELEETT [
Quey M |Ping |
[~ Loaded MIB Modules.
Modu identl T Root 0ID T Nodes| size T Path
@IRFCT1555MI 0 11 14188 CAProgram Files\MG-SOFT\MIB Browser\SMIDBARFCT165-SMLsmidb.
QIRFCT213MIB 136121 206 920078 C:\Progiam Fles\MG SOFTAMIE Browser\SMIDEARFC1Z1 3MIB.smidb
A4 @ v]v|
MIE Modties | WiB Groups
Module denl I
@1MGSOFT MGBEEPMIB
@IMGSOFT-SMI
QIRFCI2I5TRAP
@ SNMPv2-MIB
@ SNMPY2.5MI

e T @ 000 @




4)
From the Query tab, expand the MIB Tree and select ifEntry under interfaces.  Click the Table View Button located between the action and tools menus.  Ensure that the IP of the Switch 147.51.166.26 is entered for the Remote SNMP Agent.  Once the process is complete, all the interfaces on the switch should appear in the window. Your student # will correspond to the interface in the ifDescr.  


Q1 - What is the ifIndex for your system?

 
___________________________
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5)
Close the window. Click on " - " in front of the interfaces folder to collapse the tree. Select rmon  > statistics and highlight etherStatsTable. Click Table View and ensure that the Switch's IP Address appear in the window. Verify that information is being collected for your interface.
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6)
To check the performance of an object, select the performance graph from the tools menu.
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a.
Select the new graph button.  
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b.  Select the protocol preference button.           Verify the 

settings are the same as the screen shot to the right. 

Click OK. 


c.
Enter the IP address of the switch in the Agent box: 


147.51.166.26


d.  Select the object identifier (OID) button.             From the RMON\Statistics, highlight the etherStatsPkts.  Ensure the Run index discovery box is checked before clicking the OK button.  

e.
Double click on 256 from Instance Table.  

f.   Click OK on the graph properties. 

g.  Change the seconds to 20 and press Tab.  

Note:  The graph displayed is an RMON probe that is accumulative

or rising.
7)
Exit MG-Soft MIB Browser when complete.


Q2 - What does the etherStatsPkt (OID 1.3.6.1.2.1.16.1.1.1.5.) measure?


______________________________________________________


______________________________________________________


______________________________________________________

Defining an RMON Probe using TrafficDirector

TrafficDirector gives you a top-level view of your network by monitoring selected

MAC-layer statistics for the agents or switches you select (agents must contain the RMON

domain). By monitoring statistics such as utilization, multicasts, and network errors with Traffic

Monitor, you can quickly assess the performance and functionality of your network. You

can use Traffic Monitor to graphically display network traffic statistics simultaneously for

a number of selected agents and compare multiple network segments. You can monitor

network traffic patterns to see where bottlenecks are occurring and help isolate and

eliminate problems. You can use Traffic Monitor to detect high collision rates, error

packets, and broadcast storms, among other conditions.

1)
Follow the steps below to define a RMON probe in TrafficDirector: 
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a)
Start Traffic Director application by double clicking the Start Traffic Director icon on 

your desktop. 


               


b)
Select the "Admin" radio button in the upper right-hand corner and the “Agent” radio button in the upper left-hand corner.  NOTE:  Agent will be used to refer to the RMON Probe when referencing commands or display items in TrafficDirector for the purpose of clarity in completing the LAB.  The actual term for an RMON agent is a PROBE.  

c)
Click on the "Config Manager" icon. This will open up the Configuration Manager 

window.
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d)
Select the "Agent" radio button, then click "Add...". 


e)
When the "Add Agent" window is displayed complete the following:

· Agent Name: Specify a name for the switch being defined. The name you choose can be up to 15 alphanumeric characters and is case-sensitive:  FA24_Lab_STUDXX, where XX is your machine number.

· IP Address - Enter the switch IP address (147.51.166.26). This must be a valid IP address and must consist of numbers separated by decimal points in the format (a.b.c.d)   
· Interface:  Enter the ifIndex that corresponds to your system from Q1.  If you enter the wrong ifIndex the statistics you collect will not correspond to your system.  Check with the TA to ensure you have entered the proper ifIndex for your system.
· Network:  Change to FastET-HDX.  
· Read Community - Enter public. This is your read-only SNMP community string on the switch. This should always correspond to the read-only community string defined on the device you are monitoring.

· Write Community - Enter private. This is your read-write SNMP community string on the switch. This should always correspond to the read-write community string defined on the device you are monitoring. Note: If the read-only and read-write community strings do not match the read and write community names configured on the device, the TrafficDirector application is denied access to the MIB data on the device.

· All other items can be left as the defaults.

f)  After entering the required information, click the "OK" button. The window disappears, and you go back to the Configuration Manager Window.

Note: The newly configured switch should appear in the upper, left window of the Configuration Manager window.  If interfaces in your network change, you must click the Learn button so the TrafficDirector application can learn about the changes. 


g) To test the operational status of the agent you have just added to TrafficDirector, click the "Test" button on the Configuration Manager window. The TrafficDirector application queries the switch and displays a message informing you of the results: 

2)
Establishing Short-Term History and Long Term History Collection

To tell a roving agent what data to collect and when, the TrafficDirector configuration process requires that you use a properties file to define the necessary parameters. The default properties of TrafficDirector allows for the following tasks:

· Define a common set of domains to be tracked at the SwitchProbe device or Network 


Analysis Module.

· Set parameters to initiate logging intervals at the SQL database for trend reporting.

· Define SNMP trap messages that can be displayed in Alert Monitor when certain conditions occur.

3)
Using Short-Term History:  You can use Short-Term History to display snapshots of the various RMON 1 statistical counters stored in the memory of roving agent. The snapshots are displayed in a graphical format over a period of time. This display lets you look at spikes in utilization to determine areas of concern. You can zoom in on an area of concern to get a better view by clicking on two points of the graph.  Long-Term History is similar to Short-Term, the only difference between the two is the number of samples per period and length of the period.   

Note:  You must enable short-term and long-term history for RMON before the History applications will show any data. 

To enable short-term/long-term history, follow these steps:
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a)
Click "Property…" to edit the properties file.
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b)
From Property Editor, highlight the RMON domain and click Edit.


d)
Set Stats to enable and Stats Logging to 5 minutes.


e)
Check the Short-Term History box. This will establish the intervals for the short-term 

history information (samples and buckets) to be installed on the RMON Probe.  Set the sample period to 30 seconds, and the default number of samples (buckets) to 50.

 
f)
Check the Long-Term History box. This will establish the intervals for the long-term history information (samples and buckets) to be installed on the RMON Probe.  Set the sample period to 30 minutes (1800 seconds), and the default number of samples (buckets) to 50.
g)
Click OK to accept the values and the close window ‘X’ in the upper right-hand corner of the Property Editor window.


h)
Scroll until you find the RMON domain in the upper right hand window of the Configuration Manager.  Verify those configurations you have just made are displayed under the RMON Domain.  Your display should be similar to the following:





i)
Your configurations are now set, but the configurations have not been installed on the RMON probe.  
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j)
Activate EtherReal (ensure that the Enable Network Name Resolution is turned off). Type "UDP Port 161" for the Filter and begin to capture packets.  Minimize EtherReal and return to TrafficDirector.
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k)
 Install the configuration to the RMON probe by clicking the Install button on the Configuration Manager.  At the Properties Files Installations Options window, select the Add to Agent Properties radio button, then click OK.  
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l)
Stop EtherReal once the hourglass icon for the mouse changes back to an arrow.  Click on the "+ Simple Network Management Protocol" to view the SNMP information. Scroll through packet numbers 190 thru 200 until you see a Set PDU with an Object Identifier that begins with "1.3.6.1.2.1.16.2.1.1".  Answer the following questions.   

Note:  Use MG-Soft and the RMON MIB for assistance.

What is the full Object Identifier for the packet?


______________________________________


What is the object name? 


______________________________________


What is the community string?


______________________________________


What is the numeric value and what does it mean?


_______________________________________

j)
Find a SNMP Response Packet with a single entry OID that begins with "1.3.6.1.2.1.16.11…".   

What is the actual OID for this packet? 

_________________________________________

What is the SNMP Error Status? 

_________________________________________

Why did the RMON Probe return this Error Status?  

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________
View RMON Probe Statistics
To view the Short-Term History, follow these steps:
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a)
From the TrafficDirector main window select the Agent and Traffic radio buttons.


b)
Highlight your Agent Name from the agent list box.

c)
Select the RMON Domain.

d)
Click the Short-Term History icon located below the Traffic Radio Button.  A graph displaying the statistic your RMON Probe has collected will be displayed.

e)
Experiment with the different options under View and Format.  Note:  Since the RMON probe we are using is only a Mini-RMON probe, the Data Capture application does not function and will generate an error.  

f)
You can view your Long-Term History, by selecting the Long-Term History Icon from the TrafficDirector main window.  The Long-Term History graph will be blank until the time interval you set your Long-Term History sample interval (seconds) has passed; in this case 30 minutes from the time you installed the configuration on your RMON Probe.

g)
From the TrafficDirector main window Highlight the Agent and click on the Segment Zoom Icon. 

h)
Click on the packet destination graph in the slice that corresponds to unicast packets. A window will pop up with the percentage of unicast packets on your segment. 

Monitor Entire Switch with RMON Probe 

******Notify the TA before proceeding with this section.  ********

a)
Select the Admin and  Agent  radio buttons. Click the Config Manager Icon on the TrafficDirector main window.   Select Add,  and enter the information you entered previously on page ___.  Before selecting OK, Click the View button.  The Interface Window will pop-up, click  Select All and Save As Agents buttons.   Return back to the Add Agent screen and select OK.  You should now see numerous agents identified in the Agent box.

b)
Verify that the “Agent Group” has been added by selecting the Agent Group radio button. Ensure that a group name is listed in the Agent Group Box.  You now need to install the Agent Group to enable you to collect statistics.  Click the Install button, and select Add to Agent Properties, then click OK.  The values you entered for the Long-Term and Short-Term History will be applied to these probes since the Probe properties are being applied from the same template you applied to you original agent.  TrafficDirector will install then agent properties to the switch.  (NOTE:  This process will take some time…Go grab a Coke!)

From the TrafficDirector main window, select the Agent Group radio button, highlight Your Agent Group, click in the Traffic Radio button, ensure the RMON domain is highlighted, then click on the Traffic Monitor Icon.   Change View to Vital Signs.  Now open your web browser and goto the following web pages, ensure the pages fully load before proceeding to the next site:


www.msn.com


www.cnn.com


www.amazon.com

Close your web browser.  Look at your statistics monitor for the next three polling intervals.  

 
What happened to your vital Statistics? Why?  


______________________________________________________________________


______________________________________________________________________


______________________________________________________________________


______________________________________________________________________
Now, select Applications, Short-Term History, your agent #, then Launch.  

What does this show you?  Change the views to see what can be monitored.  Print your Short-term history.
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